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PRETORIA PHOTOGRAPHIC SOCIETY 

www.pretoriaphotographic.co.za 

PO Box 73056, Lynnwood Ridge, 0040 

Photo-Vault-Online Entries 

www.photovaultonline.com 

COMMITTEE MEMBERS 
 

President/Formal 

Meetings/Public Relations 

Thelma v.d. Schyff president@pretoriaphotographic.co.za  

thelma@aeternoplanning.com 

082 784 0392 

 

Vice President/Internal 

Liaison/ New Members 

Pine Pienaar pienaar459@gmail.com 076 833 6613 

Informal Meetings / 

Photo Café 

John Tapuch john@ecofab.co.za 
 

083 653 2438 

General Secretary 
Competition Secretary 

Sonja de Klerk ppsannouncements@gmail.com 

sonsdeklerk@gmail.com 

082 778 9249 

Treasurer 

Finances/Membership 

Frans Mohr pps.finances@gmail.com 083 227 8676 

Website/Social Media 
 

Carina Munday  carina.munday@gmail.com 082 322 9895 

Special Interest groups 
 

Santie van Eck santie@wildspanhunting.com 076 733 4466 

Photovault Team/ TOP 

 

Karin du Toit 

Hendrik Grobbelaar 

pvo@pretoriaphotographic.co.za  

Outings/Workshops 

 

Giuseppe Carbonatto outings@pretoriaphotographic.co.za 082 332 5748 

e-Flash Editor Joan Fouché joan.fotracon@gmail.com 082 410 7678 

Refreshments 

 

Diana van de Wiel eswdiana@gmail.com 083 527 8237 

                        

 

ORGANISATION WEB-SITE LINK 

Steve’s Digicams ( Reviews) www.steves-digicams.com 

Digital photography review www.dpreview.com 

Photoanswers ( Practical Photography) www.photoanswers.co.uk 

  

  

http://www.pretoriaphotographic.co.za/
http://www.photovaultonline.com/
mailto:thelma@aeternoplanning.com
mailto:pienaar459@gmail.com
mailto:john@ecofab.co.za
mailto:sonsdeklerk@gmail.com
mailto:eswdiana@gmail.com
http://www.steves-digicams.com/
http://www.dpreview.com/
http://www.photoanswers.co.uk/
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            NEW MEMBERS 

Pine Pienaar our Vice President is the contact 

for answers on new membership and the 

workings of the Pretoria Photographic Society.   

Contact Pine at pienaar459@gmail.com 

As per usual, the annual subscription fees are 

reduced by half for members who join after 

January. 

 
 
 
 
 

 
 
 

 

 
 
 
 
 

                   PROMOTIONS 
 

 

 

PLEASE REMEMBER when you receive a 

promotion to update the Star Level on 

PhotovaultOnline before your next entry.  These 

levels should just be a single digit: 1, 2, 3, 4, 5. 

 

KNOWING YOUR STATUS IN STAR RATING 

Photovault can now generate this information.  

Please verify your rating to ensure that 

Photovault is correct.   Please contact Sonja de 

Klerk at sonsdeklerk@gmail.com 

                   WHAT’S HAPPENING   
2 January 2024 

No Meeting 

 

Photo Café  @ NG 

Church Lynwood Sussex 

Avenue 19H00 

16 January 2024 

Hybrid meeting 

 

 Formal Meeting @ NG 

Church Lynwood Sussex 

Avenue 18H45 

Judges: 

November 2023 

Martin Kellerman 
Henri le Roux 
Schalk Engelbrecht 
(George Camera Club) 

mailto:pienaar459@gmail.com
mailto:sonsdeklerk@gmail.com
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                                           END OF YEAR CATEGORIES 2024 

The competition categories for the Junior and Senior streams are: 

Landscapes 
Outdoors scenes, seascapes, urban/cityscapes.   
Manipulation is allowed. 

Visual Art 
 Photography 

Achieving an artistic effect through application of creative 
techniques. 

Nature 

Living, natural organisms (undomesticated) in their natural 
habitats. Plants and animals included.  
Excluded: Scenic/ landscapes/ cityscapes.  
Images may not be manipulated and must conform to the 
PSSA Ethical Guidelines 

Macro and Floral 
 

Includes both Macro (Close-up pictures of any subjects) and 
Floral (Flowers in their natural state or under controlled 
conditions) 

Photojournalism 
Newsworthy, story-telling pictures including sport.  
Images may not be manipulated 

Portraits 
Includes both Animal and Human portraits.   Images may be 
manipulated. 

Pictorial 
Open category.   
It includes Architecture. 

Monochrome 
In this category the subject is totally open. Colour images 
will be disqualified. 

Best of the Year All category winners will compete automatically 

Most Versatile Author 

Entrants shall submit a panel of five (5) images each 
selected from five (5) different categories. These may 
include images entered for other awards, including 
monochrome images. 

Most Golds and COM’s 

The member who achieved the most Gold and COM awards 
in monthly competitions, as recorded in the results of the 
competitions 

Article for e-flash 
 
Most articles written for the e-Flash 

Photo Essay The best photo essay entered in the competition 
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INNING THEMES 2024 
MONTH INNING THEME DESCRIPTION 

JANUARY Solo Pet Portraiture Only one pet portraiture 

FEBRUARY Reflections, no water No reflections in water 

MARCH Oil on water in colour Oily patterns in water 

APRIL Minimalistic Flower Only flowers and minimalism 

MAY Visual Art In camera or post edited manipulation is encouraged. 

JUNE Shadows Shadows must be the main object in your composition 

JULY Double exposure In camera double exposure 

AUGUST Minimalism in any form Any genre minimalism 

SEPTEMBER Emotions  Emotions in human or animal subjects 

OCTOBER Vintage objects Focus on vintage objects, tools or any detailed object. 

 
 
 
 
 

SET SUBJECTS 2024 
MONTH SET SUBJECT DESCRIPTION 

JANUARY 

Monochrome 
Minimalism in any 
Genre 

Eliminate the clutter with clean lines, empty spaces and 
only the essential elements 

FEBRUARY  Blue sky thinking 
Make the special "Blue light" just after sunset or before 
sunrise the focus of your land, sea, or cityscape. 
 

MARCH 
Fine Art Colour Image 
using negative space 

Create a Fine Art Colour Image using negative space. Use 
artistic freedom to manipulate the image 

APRIL  Low Light Photography 

Astro, Milky Way, star or light trails, Cityscapes, 
amusement parks or street photography using only 
existing light. 

MAY 
Macro or Closeup 
Patterns in Nature 

Focus on the natural world by filling the frame with your 
subject. Illustrate patterns, leading lines, or repetition. 

JUNE Panorama  
Use symmetry, mirroring, or repetition as an instrument 
to enhance a Panoramic image. 
 

JULY 
Create Silhouettes or 
shadows  

 Enhance the characteristics of any living creature in any 
genre or colour. 
 

AUGUST 

Patterns, Repetition or 
Reflection to enhance 
Architectural Details  

Focus on Patterns, Repetition or Reflection to enhance 
Architectural Details in an image. 

SEPTEMBER 
 Pictorial Landscapes/ 
abandoned buildings  

Create a Pictorial Landscapes with abandoned buildings 
as focal point.  
 

OCTOBER 
Flowers, leaves or 
insects as subjects  

 Put all emphasis on the detail by use of focus stacking, 
or in contrast create out-of-focus images using 
movement, colour contrast, negative space and bokeh. 
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                                      RULES FOR OUTING AND INNINGS 

In terms of a resolution taken at a General Meeting on 4 October 2022 members will have an 
option to enter either an Outings image or an Innings image as an additional entry during the 
monthly completion, as from 2023. This will ensure that members who are unable to attend a 
monthly outing to also have an opportunity to participate and embark on a creative challenge 
each month. 
Members can enter either an Inning image or an Outing image, but not both. 
Inning images can only be entered in the month specified for a specific topic, e.g., January – 
Something in the Kitchen 
An outing image may also be entered in the month following the outing. 
Only one image per inning or outing is allowed. 
Clearly mark your image as _I for Innings and _O for Outings.   E.g. Chasing each other O 

 
 

                                 SERVICE TO THE CLUB: 
You can serve the club by providing two or more of the services listed below throughout the year. 
Remember you must provide regular service to the club for it to qualify.  

List of services:  
• Judging at the monthly 

competitions.   
• Writing articles for the e-Flash.   
• Writing tutorials for the e-Flash.   
• Assisting with / hosting outings.   
• Assisting with / hosting workshops.   
• Assisting with / hosting tutorials.   

 

• Providing snacks and refreshments for 
informal meetings.   

• Organising a speaker or speaking yourself 
for either the informal or formal 
meetings.   

• Photographing the year-end function.  
• Organising the end of year function. 

 
 
 
 
 
 

                           MONTHLY ENTRIES FOR CLUB COMPETITIONS: 
Dear PPS club members 
When entering your photos for the formal evenings, could you please do the following:  
You are allowed three entries in either the Open category or Visual Art category,  
and one entry in the Set Subject category.  
Only members who have judged the previous month are allowed to enter more images. 
For your extra entries (workshop/outing/innings/resubmission) mark your entries as such: 
Workshop: 
Model in a red dress_W  
Resubmission: 
Sunset over the dam_RS  
Outing: Newtown_O    
Inning:   Kitchen_I  
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NATIONAL SALON DATES 2024  

OTRCC 3rd National Digital Salon 6 January 2024 

PSSA National AV Salon 13 January 2024 

Bloemfontein CC Salon 20 January 2024 

Ermelo Fotoklub 4th National Digital Salon 3 February 2024 

AFO 12th National Digital Salon 10 February 2024 

Boksburg National Digital Salon 24 February 2024 

Brandpunt Fotoklub Nasionale Digitale Salon 9 March 2024 

Visit www.pssa.co.za for more information and entry forms. 

 
All salon results administered by Photovault are registered automatically by the system. Please 

ensure correctness of your details in Photovault regularly. Those salons, not using Photovault still 

need to be captured manually. Contact Sonja de Klerk if there are any discrepancies, at 

ppsannouncements@gmail.com  
 

 We would like to motivate all members to take part in the PSSA salon and international scene where 

possible. Advancement from 3-star and 4-star require a few salon acceptances.  The salon 

acceptances that are used to calculate promotions have a cut-off date 14 days before the meeting, 

to allow the competition secretary to update files. Acceptances after this date will be considered 

the next month.  

                                                    

http://www.pssa.co.za/
mailto:ppsannouncements@gmail.com
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                                             SALON ACCEPTANCES 

National Salons 
 

6th Vanderbijlparkse Fotografiese 
Vereniging Salon  
 
Giuseppe Carbonatto  
On a mission  
 
Sonja De Klerk 
Free style  
I am on a diet  
The winter girl  
Letotse  
A painting by nature  
 
Frans Fouché 
Wild flower  
Approaching a flower  
Hanging on 1  
 
John Tapuch 
Light intrusion.  
The overflow  
Drakensberg Cascades 2 
 
Joan Fouché 
Finding a way out  
Finding nectar  
Mexican Butterfly weed  COM 
 

 
 
 
 
 
 
 

4TH SHPC National PDI Salon - 2023 
 
Giuseppe Carbonatto 
Mother and cub  
Mirror mirror  
Pushing it  
 
Sonja De Klerk 
Testing the water  
A mouthful  
Dusted  
Team work  
 
Joan Fouché 
Warming up 2  
 
Santie van Eck 
The Dawn of a new Day  
Ok Let Me Think about it  
Not all those who wander are lost 

 
International Salons 
 

11th Olympic Photo Circuit 2023 
Sonja de Klerk 
Letotse 
I am stuck 
Team work 
 
Kangeroo Circuit 2023 
Sonja de Klerk 
My Ride 
Hallo there 
 
Wild Rhino Circuit 2023 
Sonja de Klerk 
A thirsty family 
Team work 
Framed by my mom 
She is coming with me 
In the air 
Spout and spit 
Ouch 
A royal wave 
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Outdoor Photo: 

 
   

                       
Contact Nr:  (012) 348 3693/ www.outdoorphoto.co.za 
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President’s Page - Thelma v.d. Schyff 
RESOLUTIONS, OH RESOLUTIONS......... 
 
Well, here we are – slap dash in 2024. 

 

When one moves into a new house, one tends to have spring cleaning fever. When one buys a new car, one 

washes it more often in the beginning. When one gets a new stove, one wants to cook more or 

better................... Now I am getting carried away. It is so not going to happen. 

 

With a whole year ahead of you, you must decide what you are going to do differently, with emphasis on 

photography. Do you want to try a new genre, shoot with your smart phone or just enjoy your hobby? 

 

 Whatever you feel like doing, you might consider some suggestions for the year to come. 

1. Get to know your gear well. 

Were you lucky enough to get a new camera for Christmas? Have you upgraded to mirrorless? Now is the 

time to get to grips with your camera. Look again at shutter speed and its importance, at aperture and how 

it can change your photo and find out again why white balance set manually, can improve your shots. 

2. Try something new 

Put on your boots and learn a new piece of editing software or a different photography technique. 

Why not try your hand at high-speed photography? The results are so rewarding. 

 

How about tilt shift photography? 

In tilt shift photography the camera remains stationary while mounted on a tripod (or handheld if you are 

steady) and now you tilt the camera up or down. This move shifts the audience's attention from one area 

to another, vertically extending the range of the visual scope of the shot. 
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This is a creative and unique type of photography in which the camera is manipulated so that a life-sized 

location or subject looks like a miniature-scale model. 

  

3. I will take my camera with me more often 

Many of us are guilty of leaving the camera at home, where, if we had in it in the bag or car, we will take 

more photos. Even your smartphone will suffice with cameras getting better all the time. You may not get a 

winner but might still learn something from what you captured. 

4. I will make the most of the gear I have. 

It is possible to take good photos even if you do not have the latest camera on the market, with a long lens 

to go. Rather focus on the capabilities of your camera and use it to its full advantage. When you do not 

have a long lens for wildlife, try another option. Visit a game farm that takes you close to the animals, even 

visit the zoo and do close ups of the animals there. Do not forget of our own Rietvlei on our doorstep, 

where animals can come close to your vehicle. 

5. There is one other challenge I would like to bring to your attention. The “365” is the ultimate 

photographic challenge. It would probably require that you create a side Instagram account, but this is 

mainly to hold you accountable. (Not like your gym membership that falls behind quickly).   

A 365-photo challenge is a project where you capture an image every day for a year. You receive a calendar 

that tells you what your daily shoot must be. The long and short of it is that you can learn a lot through this 

challenge. You can learn new technical details and get familiar with different sides and genres of 

photography. 

      

As you are given ideas each day, it forces you to rely on your creativity. It gets you to shoot every day and 

drags you out of your comfort zone. 

Now that is a thought. 

Can I wish you a creative 2024, not shying away from challenges. 

Regards 

Thelma 
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End of Year Winning Photos 2023:     
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Article: 
How to Use Overlays in Photoshop - By 
Linda Martin 
Article taken from fixthephoto.com 
 

I have been experimenting with and fully enjoying the compositing experience that Photoshop is famous for.  

My creations have got smoother and I hope a lot more interesting.  My last Photobook creation was a case 

in point.  I used the compositing experience to the max.  It was both liberating and maddening in 

complexity.  Apart from the concept and photographing the puppet models, all other components had to be 

added via ‘OVERLAYS’   

I came upon this article about how to use an overlay for anyone who has not tried it before.  This is a 

simplified step-by-step version that uses specially designed downloadable overlays that usually have black 

backgrounds.   Doing your own is not wildly difficult but that is another subject altogether. 
 

If you want to embellish your photos with interesting elements, e.g., feathers, stars, leaves and snowflakes,  

you can use Photoshop overlays. These are special filters that you can apply to JPEG and PNG images as an 

extra layer. Read this guide on how to use overlays in Photoshop and start experimenting straight away. 

 

1. Select a Photo 

    Next choose File>Open 

2. Paste the Overlay onto the Photo 

 

https://prf.hn/l/8xovAoQ
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You need to drag and drop the overlay you like onto the picture.  It will be automatically displayed as a new 

layer.  The photo was taken in winter lacks some fairytale atmosphere, so I will use a snow overlay.  

You can add smoke in Photoshop or any other effect that can match your image. 

If needed, you can resize a layer in Photoshop.  Doing this is simple.  You just need to open Image > Image 

Size or use ctrl-T and use the resize handles to enlarge the overlay image. 

Make the needed adjustments in the window and double-click on the photo to accept changes. 

 

3. Choose a Blend Mode 

 

Similar to adding texture in Photoshop, you need to change the blend mode, after adding an overlay.  With 

the help of blending modes, you can combine and overlap pictures the way you like 

It is important to experiment with blending modes while learning how to use overlays so that you can 

instantly understand what results you will get by choosing different modes.  By default, the blend mode is 

set to Normal.  I recommend changing your Blend Mode to Screen.  You have probably seen that my 

overlay has a black background.  With “Screen” mode on, all pure black parts will disappear and there will 

be only snow visible. (The light or white parts) 

 

Tip: It often happens that the colour of an overlay and the general colour gamut of your image are 

unmatched.  You can easily fix this by creating an adjustment layer, by opening Image >Adjustments > 

Hue/Saturation. 

4. Add a Layer Mask to Hide Parts of an Overlay 
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It is crucial to learn how to mask in Photoshop. 

First off, go to the Layers panel and select an overlay there.  You need to click the  “Add layer mask” button 

located in the lower part of the panel. 

There will appear a white layer mask thumbnail next to the selected layer, which is needed for hiding parts 

of your overlay.  For example, if you apply an overlay to a portrait image, you definitely want models’ faces 

to be perfectly visible.  So, any part of an overlay that covers the forehead, eyes, etc., should be hidden. 

 

5. Select the Brush Tool from the Tools Panel 

 

 

Learning how to use Photoshop overlays is simple, as the range of tools you will have to utilize is rather 

small.  At this stage, you need to select the Brush tool (B) from the Tools panel and set it to black. (D key 

resets).  Keep in mind that a pack of available instruments is sufficient for basic tasks. However, you may 

need to install Photoshop brushes shared on the net for more sophisticated adjustments. 

 

6. Enter the Brush Settings 

 

Feel free to alter brush settings. For instance, you can modify the opacity and hardness the way you want.  

However, I recommend sticking to 41% on flow. 

Feel free to alter brush settings. For instance, you can modify the opacity and hardness the way you want. 

However, I recommend sticking to 41%. 
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7. Hide Parts of the Overlay 

 

 

Now, you can conceal any piece of an overlay.  Keep in mind that you should use black to erase and white 

to recover.  Fortunately, all changes made are non-destructive. 

In other words, you can always return to the previous stage by changing the brush’s colour to white (X key 

toggles) and moving it over the areas you need to recover.  I will concentrate on deleting an overlay from 

people’s faces because I think this part of a photo should have no distractions. 

Tip 

Adjust the layer opacity to refine your overlay even more. 

 

8. Done 
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                                             PHOTO CAFÉ 2023/2024 
SEPTEMBER 2023  

5 September Photo Essay presentations and 
announcing of winners 
 

 

OCTOBER 2023  

3 October 
Photo Stacking demo by Tony Roberts 
Rear Front sink flashing by Giuseppe Carbonatto 
 

 

NOVEMBER 2023  

7 November 
Guest speaker:  Neville Peterson - Industrial 
Photographer 
Francois Venter - Criterium and tips regarding 
salons 

 

              OUTINGS/ WORKSHOPS/ PHOTO OPPORTUNITIES 2023/2024 
SEPTEMBER 2023 SEPTEMBER 2023 

3 September Fire event: 

 
Dea ex Machina – Tony Roberts 
 
 

9 September - Flower workshop - Jan Cillierpark: 
 
19 September - Rhino of the Mapungupwe Ballet 
rehearsal  
 
30 September – Klitsgras Drum Beating  
 

OCTOBER 2023  DECEMBER 2023 

13 October Gentle Introduction to Drag Hunting 
at the Inanda Country Base 
 

13 December  Queen Ballet  - Monte Casino 
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PPS Birthday list: 
January February 

Marianne Ver Loren van Themaat 1 Vanessa Price 6 

Gerrit van Rooyen 19 Gurling Bothma 18 

  

  

March April 

Christelle Swart 6 Casper van Eck 11 

Rudi Pothas 13 Carina Munday 24 

Fransie Stevens 21  

Linda Martin   22  

  

May June 

Detlef Basel  23 Suretha du Plessis 11 

Frans Fouché 30 Jing Chen 13 

 Joan Fouché 16 

 Lloyd Munday 18 

 Marius Coetzee 30 

  

July August 

Diana van de Wiel 4 Tony Roberts 6 

Robin Miles  9 Cata Schramm 9 

Johan Ver Loren van Themaat 21 Sonja de Klerk 10 

 Bill Zurich 16 

 George Stevens 16 

 Almari Coetzee 17 

 Ann Roberts 23 

 Brigitte Hansen 25 

  

September October 

 John Tapuch 1 

 Thelma van der Schyff 8 

 Huan Zhongjie 12 

 Chantelle J v Rensburg 24 

  

November December  

Santie van Eck 6 Brendan Hohls 1 

Johan Hosten 9 Giuseppe Carbonatto 1 

Karin du Toit 11 Hendrik Grobbelaar 24 

Giel du Toit 15 Pine Pienaar 26 

Frans Mohr 21 Marlene Birkholtz 31 

Bruno Engel 21  

  

  

 
Please send your date of birth to Joan Fouché if your name is not on the list.      


